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Introduction

This cookbook contains tips and tutorials for Sitecore CMS content editors. The
document consists of the following chapters:

e Chapter 1 — Introduction

e Chapter 2 — Managing Content

e Chapter 3 — Managing Languages
e Chapter 4 — Publishing Content

e Chapter 5 — Maintaining Search

e Chapter 6 — Administrator’s Notes
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1.1 Accessing Sitecore

Users access the Sitecore web interfaces via the Sitecore login page. Access the login page by typing
“sitecore” at the end of the base URL for the site. For example, if the site URL is:

http://www.mysite.com/
then you can access the Sitecore login page via:
http://www.mysite.com/sitecore

The login page is shown in the following image:

(= Sitecore - Windows Internet Explorer E||E|E‘
@ \;:/. b4 \g htip://locathost/sitecore/loging V| hedlB | | 21
w & I@Sitecnre I_I i f - B - @ - [ErPage v £ Took v ”

=]

Q sitecore’
@ Welcome to Sitecore

@ Login

Forgot Your Password?  Change Passward

What do you want to do Browser Notes @

You are using Internet Explorer 7.

Please choose an activity... Sitecore supports all user inter faces for
this browser.

Adobe Flash Player 10
Warning

Adabe has released version 10 of
Flash Player which prevents you
from uploading files to the Media
Library in Sitecore CMS 6.

Please install Sitecore CMS 6.0.0
update rev, 081022 (Update-6)
Edit Web Site Use Content Editor to resolve this issue.

Alternatively, set the
Upload. Classic setting in the

Advanced Options... web.config to ‘true’.
Hide Warning
Visit www.sitecore.net NET 3.5 SP1 Warning
K
Dione J Trusted sites A% -

Choose the login options (described below), enter your user name and password and click “Login” to
login.

The following paragraphs describe the controls and areas of the login page.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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1. Login/Advanced links.

Use these links to switch between the advanced and the simple login views. The simple login
view allows to choose between the Page Editor and the Content Editor while the Advanced
view provides more options which determine which interface a user will see after logging in.
Take a look:

Login view

What do you want to do

Please choose an activity...

Edit Web Site Use Content Editor

Advanced Options...

Advanced view
Select User Interface

@ Desktop w Content Editor
@ Page Editor Eg Preview

-:') Workbox -a Developer Center

Browser Display Mode:  Normal v

The Advanced View is described in detail in a section further in this document.

2. Login Form.

Enter your login and password here and click the Login button to login.

Note: The username is case insensitive, while the password is case sensitive. It means that if
your username is Claire, you will be successfully logged in as claire. However, if your
password is MyPassword, then mypassword will not work.

Sitecore will remember the last username and other options provided.

The Forgot Your Password and Change Password links allow to retrieve a forgotten password
and change your password (you need to enter the current password in order to change it).

3. License and version information.
View the information about the current installation, including the exact release of Sitecore that
iS running.

4. Browser notes.

View the important notes concerning the browser used and other important notices.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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1.1.1 Advanced Login Mode

In the Advanced Login Mode users can select which interface to display after the username and
password have been validated.

Welcome to Sitecore

User name: |Audrey |

Password: | |

Forgot Your Password?  Change Password

Select User Interface

| Desktop w Content Editor
@ Page Editor k Preview
T ) Workbox a Developer Center

Client Language: | Default v

Note: Administrators may override this option for certain users, thus forcing these users to always
start in a specific interface.

The Advanced mode also provides the following settings:

e Browser Display Mode.
This setting has three options: Normal, Without Toolbars, Fullscreen.

sroser iy Hode:

Normal

Without Toolbars
Fullscreen

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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e Client Language.
The Client Language setting allows selecting the language in which the client functionality is

displayed.
Client Language: | Default v
Default
Danish

Dutch ENetherIandsi

French (Canada)

German

Morwegian, Bokmal (Norway)
Swedish (Sweden)

The client language selection affects only the language in which buttons and descriptions are
displayed in the interface. The content language, however, is managed separately.
Administrators can specify the default content language on a per-user (via the Edit User
dialog) or per-site basis (via the shell site element in the web.config file).

If some of the languages do not have complete translations, English versions will be shown
for items where a translation is unavailable.

“Default” means that the client language set in the User Properties for a username provided is
set. The default client language for all users in Sitecore is English. However, it is possible to
change the default language for a certain user.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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Managing Content

This chapter contains tips on managing items in the content tree, using media library,
uploading files and using item versioning features.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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2.1 Managing Items in the Content Tree
There are several ways to move, create, and edit items in the content tree:
1. Use the appropriate groups and buttons on the Home tab.
2. Use the context menu (right-click an item).
3. Use the drag&drop feature.
4. Use the Clipboard group in the Home tab to cut/copy and paste items.

In this document, each action is usually described using the first approach in detail with some brief

explanations of the other approaches.
Note:
Some parts of the Content Tree may be hidden due to the Content Editor settings.

You should check the Hidden Items checkbox in the View tab to see the Layout, System and

Templates items. If you do not see the Media Library in the Content Editor, check the Entire Tree

checkbox.

Home Navigate Review Fublish Versions Configure Presentation Security

Content Tree Hidden Items [ Raw values

Entire Tree [ standard Fields
View

2.1.1 Copying an Item to another Location
To copy an item to another location:
1. Inthe content tree, select the item that you want to copy.

2. Onthe Home tab, in the Operations group, click Copy To.

Dupiicate (2 Move To pelete ~
Operations

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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3. Inthe Copy Item To dialog box, select the location that you want to copy the item to.

A Sitecore -- Webpage Dialog @
= Copy Item To
Select the location where you want to copy the item to.

=[] sitecore
= & Content
= #) Home
EC] Standard-Ttems
= 13 Products
= & Home-Products
'@ Cool-o-matic
3 wash-o-matic

>

:
& vacation-Products
2 services
‘@ References
55 |

|«

Name: |Is itecore/content/Home/Products/Office-Products

Copy ” Cancel ]

4. Click Copy and the item is copied to the specified location.

2.1.2  Duplicating an Item
To duplicate an existing item:
1. Inthe content tree, select the item that you want to duplicate.

2. Onthe Home tab, in the Operations group, click Duplicate and a dialog box appears
prompting you to name the new item.

Mavigate Review Publish ersions Configure Presentation

\ comTo 9@ |
I“ 3+ Copy To

| Operations

3. Enter a name for the new item and it is added to the content tree at the same level as the item
you duplicated. It also contains all of the same text, images and so on as the original item.

2.1.3 Moving an Item
To move an item:
1. Inthe content tree, locate the item that you want to move.

2. Onthe Home tab, in the Operations group, click Move To.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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3. Inthe Move ltem To dialog box, select the location that you want to move the item to.

4. Click Move to move the item to the new location.

2.1.4  Deleting an Item
To delete an item from the Web site:
1. Inthe content tree, select the item that you want to delete.

2. Onthe Home tab, in the Operations group, click Delete.

‘ Home i

[ tnsert from Template (1 of 1) |1 —ED—@-CEEWID
Save || Edit~ = || Duplicate [ Move Tol pelete
. Operatio

The item is deleted from the Web site.

If you try to delete an item that contains sub-items, a message will appear informing you that that the
section contains sub-items and that these items will be deleted along with the main item.

Windows Internet Explorer

&

Are you sure you wank to delete "Novelty Products"?

This item has sub-items which will lso be deleted F vou delete this item,

If you want to save any of the items, you must move them to another part of the Web site. Click OK to
delete the item and its subitems.

If you want to delete only the subitems of the selected item, click the triangle next to the Delete button
and select the Delete Subitems button.

o 38 [ ) %

@Mdve T0 | Delete v || Paste
Delete Subitems

2.1.5 Renaming an Item

To rename an item:
1. Inthe content tree, select the item that you want to rename.
2. Onthe Home tab, in the Rename group, click Rename.
Presentation Security View

To
T0 | Delete ~

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.

Page 11 of 43



Sitecore CMS 6.0-6.2 Content Cookbook @ Slteco re

3. Inthe prompt dialog enter the new name and click OK.

A Sitecore -- Webpage Dialog

Enter a new name for the item:

The item is renamed.

Using the Rename group you can also change the Display Name of an item.

2.1.6  Sorting Items

To sort items in the content tree, use the Sorting group on the Home tab.

e Click Up to move the selected item before the previous one.
e Click Down to move the selected item after the next one.
e Click First to make the item first.

e Click Last to make the item last.

Click the advanced options icon to use the subitem sorting options.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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You will see the following window:

A Sitecore -- Webpage Dialog @
Sat the Sorting for the Subitems

ﬁj Spedify how the subitems of the item are sorted,

Sorting: | Created I~
& Hom o
& offic Default
& vace Display Name

Logical
Reverse
Updated

[Reset to Standard Value]

The Sortorder field is the first criteria for most sorting. To reset the Sortorder field of the subitems,
dick Reset.

2.1.7 Using the context menu (right-click)

Right-click an item to access the context menu which allows to perform various actions:

= @ Products
&% Homg~——
Bomg Y
& vaca = Cut
& services|| E Copy
@ Referenfl =) paste
& News {3 Duplicate
|| People
@ obs 3 Delete
_—:|Cur113ct Rename
& About-U Copying
J Meta-Data
() settings
B Layout

Sorting
@ Refresh

2.1.8 Using the drag&drop feature.
Click an item and drag it to move this item to another location.
e Drag&drop an item with the Ctrl button pressed to copy the item.

e Drag&drop an item with the Alt button pressed to change the sorting order. You can use this
feature both for sorting subitems and for moving items to another location.

2.1.9 Using the Clipboard

Use the Clipboard group in the Home tab to cut/copy and paste items.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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Configure Presentation

Select an item, click Cut, navigate to the item where you want to paste it and click Paste - the item
you cut will be created as a child of the selected item and the original item will be removed.

Copy-Paste works in the same way but the original item is not removed.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.

Page 14 of 43



Sitecore CMS 6.0-6.2 Content Cookbook @ Slteco re

2.2 Media Library

This section describes how to access the Media Library and upload files to it.

2.2.1 How to Access the Media Library?
You can access the Media Library in the following ways:
o From the Desktop, select Sitecore » Media Library.

¢ Inthe Content Editor, select Media Library in the bottom bar:

| Search L%, - |
= |[&] Media Library
) Files

i) Images

Media Library

¢ In the Content Editor, navigate to Media Library folders in the content tree (“Hidden ltems”
and “Entire Tree” checkboxes must be checked in the View tab).

2.2.2 Uploading Files to the Medial Library
To upload files to the Media Library:

1. Navigate to a folder in the Media Library. In the right part of the screen you will see the
following menu:

(o)

Search

Home: Mavigate Review

Publish Versions Configure Presentation

g’ m, Upload File (1of 33 = ED (i Copy Ta x
Edit ~ || L) Media folder (2of 3 < || puplicate (= Move To Delete +

N a Content

= &) Media Library Create a New Item.

U Files s y . oy
=g $|W T
i | Upload Files ) Upload Files  Mew Folder

’J:] Bannets (Advanced)
U Zategaries
) Help Site

2. Click Upload Files. In the prompt dialog select the files you want to upload; you can select
multiple files (by holding Ctrl while selecting or drawing the selection area):

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
contents of this document are the property of Sitecore. Copyright © 2001-2012 Sitecore. All rights reserved.
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Select file(s) to upload by localhost

Look in: l = FZ5
My Recent
Documents
L-A =
Desktop p1000001. jpg E
My Documents =
My Computer p1000078.Jpg p1000129.jpg p1000333. jpg
]
‘g File name: 51000001 jpg" “p1000014pg" 'p1000043jp ¥ | [ Open J
My Network  Files of type: lAII Files %) v [ [ Cancel ]

Click Open when done, the upload process will start and you will see a similar screen:

), Upload File

o Horng:
Save || Edit -
Search

i) Media foldar

Publish
{1of 3)

Insert =

ﬂFu\der @ Content

me
(2 of 3) E Duplicate B Mowve To  Delete + T Display fame
-

A i
W Down 3 Last

B (5] media Library
) Files
& {2 Images

8 i) iy Photos
) Banners
) Categories
i) Help Site
i Logos
2 News
i) Peaple
L Products
) References
i) Teasers
) Taakbox

Create a New Item.

Cancel

Upload Files  Upload Files  Mew Falder
(Advanced)
Uploading ..
Filenarne Sige Alesrnate Text
pl000014.jpg 1446 KB \ | ¥4
plO0000L.jpg 2481 KB \ |
pl000043.jpg 2322 KB ‘ |

3. When the upload process finishes, review the uploaded files:

Home

i

Havigate

&, Upload File
‘Lj Media Foldet

Publish
{1 of 3)

Configure

Insert ™

| vup s |
% Down 8 Last

| Search

Q "quolder\'Content

mer
(20f3) E Duplicate B’ Move T pelete T Display Mame
-

B[] Media Library
@ Files
& Images
=]

<]

& Categories
iJ Help site
J Logas

2 News

) people

) Praducts
) References

Create a New Item.

Upload Files  Upload Files  New Folder

N e 100
1 warning

(Advanced)
"
. pl000001 pl000014
2560 x 1920 .’ & 2560 1920
1 warning ﬁ\' 1 warning
pl000043

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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2.2.3 Advanced Upload Options

To use the advanced upload options, select the Upload Files (Advanced) button.

B, Upload File
‘.[.j Media Folder

10of 3 ir op
( ) - I“ [
(2 of 3) = || Duplicate [ Move To pelete
4 ns

Save || Edi~

[searcn @ ]
2 .élql‘gedia Library Create a Mew Item.
Files

=] ‘{j Images

Upload Files | Upload Files | Mevw Folder
Bianners {Advanced)

SLj Categories
) Help site

Select the files you want to upload; you can select multiple files (by holding Ctrl while selecting or
drawing the selection area):

Select file(s) to upload by localhost @
Look in: | (3 FZ5

E

My Recent
Documents

p1000014.jpg

= o
\$ 3@"
/ =\

A

My Documents

p1000078.jpg p1000129.jpg p1000333.jpg

=

<

o

(=]

3 @
h=)

=

a

i

File name: l"p1DUEIEIEI1.ipg""p1IJIJIJD144ipg""p1EIElElIJ43Aip Vl | Open l
MyNetwork  Fiesoftype: | AllFiles [*) v| [ _canca |

&

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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Click Open. The following dialog will appear:

Create a New Item.

$ @ ¢

Upload Files  Upload Files  Mew Folder
{Advanced)

These files are ready for uploading:

pl000014.jpg 1446 KB lake

pl00000L.jpg 2481 KB bird

pl000043.jpg 2322 KB blaam

O Unpack ZIP Archives [Tmake Uploaded Media Items Yersionable

[ averrite Existing Media Tterms (¥ Uplaad as Files

[ Upload ] [ Cancel ]

This dialog provides the following advanced options:

Alternate Text

Use the Alternate Text field to enter the text for the alt tag for an image.

Unpack ZIP Archives

Use this checkbox to unpack ZIP archives after they are uploaded. The archives themselves are
deleted after unpacking. If the archive contains folders, such folders will be created in the Media
Library as well. This feature is extremely useful if you need to upload a big number of files.

Overwrite Existing Media Items

Check this checkbox if you want to overwrite an existing item if you upload an item with the same
name. If the checkbox is not checked and the name of the file you upload coincides with the name of
some item which already exists in the folder you upload to, them another item with the same name
will be created.

Make Uploaded Media Items Versionable

Check this checkbox if you want to make the media items you upload versionable. By default, media
items are uploaded as non versionable (as determined by the Media.UploadAsVersionableByDefault
setting in web.config).

2.2.4  How to Upload Multiple Files in a Batch?
To upload multiple files in a batch, you should do the following:

e Create a .zip archive with files you intend to upload on your disk. You can include folders with
files — the folder structure will be preserved in the media library after extraction.

e In a media library folder, click the Upload Files (Advanced) button and select your .zip
archive using the Browse button.

e Check “Unpack ZIP archives” checkbox.

e Click the Upload button. The archive will be uploaded and extracted in the currently selected
media library folder.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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2.3 Versioning

This section describes how to work with versions in Sitecore CMS.

23.1

How to Switch Between Versions?

@ sitecore

To switch between numbered versions, click the numbered version button in the Content Editor and

choose a version:

'Conhent

@ Cool-o-matic

D Quick Info

=3 Breadcrumb

Breadcrumb Title:
Cool-o-matic

E Menu

[£) Page Title and Text

2D Related Ttems

[ sidebar

&) overview

@ Product Description

IZ' Modified 14-01-2009 12:43 by sitecore\Admin.

1. Modified 22-10-2008 18:37 by sitecore\admin.

i:'a Add Version

To switch between language versions, click the language version button in the Content Editor and

choose a language:

German (Germany) : Deutsch (Deutschland)

0 versions.

English : English

2 versions.

2.3.2

Adding a New Numbered Version

Follow the steps below to add a new numbered version to the currently selected item.

In the Content Editor, click on the version number mark in the upper right corner of the content area.

The list of versions will appear:

‘ Content

@ Cool-o-matic

o Quick Info

IZ' Maodified 14-01-2009 12:43 by sitecore\Admin.

1. Modified 22-10-2008 18:37 by sitecore\admin.

&8 Breadcrumb

Breadcrumb Title:
Cool-o-matic

fg@  Add version

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The
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Click the Add Version button in the bottom of the list. The new version in the current language will be
added.

Note
A new version is added by copying the currently selected version. All field values are copied.

Adding a New Numbered Version via the Ribbon
e Select the item for which you want to add a new version.

e Select the Versions tab in the ribbon.

Configure Presentation Security View

e Click the Add button in the Versions group. The new version in the current language will be
added.

2.3.3 Removing a Numbered Version of an Item
To remove a numbered version of an item:
e Select an item.

e Select the version you want to remove.

° Content

gi Cool-o-matic Modified 14-01-2009 16:16 by sitecore\Admin.
2. Modified 14-01-2009 12:43 by sitecore\Admin.

© quick Info

=8 Breadcrumb 1. Modified 22-10-2008 18:37 by sitecore\admin.

Breadcrumb Title:
Cool-o-matic

e Click the Remove button in the Versions group of the Versions tab.

The currently active version will be removed.

2.3.4 Checking What Has Changed Between Two Versions of an Item
To check what has changed between two versions of an item:

e Select an item in the Content Editor.
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e Onthe Versions tab, in the Versions group, Click Compare.

You will see the following dialog:

I Compare Versions
H Compare twa version of the same item. The differences are highlightad.

Two Columns

E v[2 4|

[ — |~
Product Description 8 '=

Mame: Name:

Number: Number:

Price: Price:

629,99 §729.99

Tmage: Tmage:

Description:

Description:

Thig deluxe model indudes the Freeze-o-matic  This deluxe model indudes the Freeze-o-matic
module. You won't believe your eyes, This nifty module. You won't believe your eyes. This nifty
attachment can store water in small solid attachment can store water in small solid cubes.

cubes, Amaze your guests! Amaze your guests!
f Appearance
Dizplay name: Display name:

I
"

The dialog above shows differences between versions two and three. Changes in fields are marked
with blue color.

In the image above you see the two column mode. One column mode looks like this:

A Sitecore -- Webpage Dialog @

oy Compare Versions
H Compare two version of the same item. The differences are highlighted.

Cne Column Two Calumns

Number:

|

Price:
$:7299.99
Image:

Description:

This deluxe model indudes the Freeze-o-matic module. You won't believe your eyes. This nifty
attachment can store water in small solid cubes. Amaze your guests!

I Appearance (A
w

Micnlau namas
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2.3.5 Translating Item Content into a Different Language
To translate an item content into a different language:
e Select an item you want to translate.

e Onthe Versions tab, in the Translate group, Click Translate.

Security Wiew

e Choose a language in the Language field. You will see the fields in this language in the right
column (see the image below):

.—-rurlt Wiew

a Desk Chairs

0 Quick Info
=8 Breadcrumb =

Breadcrumb Title:
Desk Chairs

i) Menu =

Menu Title:
Desk Chairs

Enter the translated text in these fields.

In the Translate group you can also see the Compare fields. You can use these fields to compare
different versions of the item right in the Content Editor window, but as against to the Compare button
in the Versions group, this feature does not highlight the differences.

2.3.6 How is a New Language Version Created?

To add a version in a different language, you should switch to this language in the Language group of
the Versions tab and add a numbered version. This numbered version will be created in the currently
selected language.

The following chapter describes how to add a new language.
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Managing Languages

This chapter describes how to add and remove languages in Sitecore CMS.
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3.1 How to Add a New Language?

To add a new language, select the /sitecore/system/Languages item and add a new language using
the Language template:

m Language
D Insert from Template

5] Media Library

= &) system
) Aliases
]
Language

Items in the Folder

Een

(1) Modules
i{_j Proxies

When you select the Language template, the following dialog appears:

A Sitecore -- Webpage Dialog @
Language Codes
Enter the language codes. Click Next to continue.

You may select a predefined language here:

German (Germany) : Deutsch (Deutschland)

The language code consists of a language identifier, for example, "en” for English and a
country/region code, for example, "US" for United States. The language code is then “en-US",

Language: |de |

E.g. "en".

Country/Region Code: |DE |
E.g. "US".

Custom Code: | |

= |ﬁag5!18x15fﬁag_Germany_PNG |

In the topmost field select the language you want to add, when you do this all other fields except for
the Custom Code field will be filled automatically.

Click Next.
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The Codepage and Encoding dialog will appear with the default settings for the selected language
entered:

A Sitecore -- Webpage Dialog

Codepage and Encoding

Enter the codepage, encoding and charset to use for displaying HTML pages in this m
language. Click Mext to continue.

Codepage: |E|5[]U1
E.g. "65001".

Encoding: |utf—8
E.g. "UtF3".

Charset: is0-3859-1
E.g. "is0-8859-1".

< Back ” Next = ]’ Cancel

Click Next.

The Spellchecker Dictionary dialog will appear with the default setting entered:

A Sitecore -- Webpage Dialog

Checker Dictionary
Enter the dictionary to use for spell chedking. Click Next to continue. m

spelchecker file path: |de-DE. tdf |
E.g. "en-UK.tdf".

Click Next, view the final window and click Finish. The language is added:

B Layout -~ ‘C]Folder\‘{:ontant o

(5] Media Library

= %) System Create a New Item.
) alizses m
% Dictionary
= m Languages Language
™ deDE Items in the Folder
Hen

() Modules ! de-DE % &n

) Proxies

Alternatively you can add a language via the Control Panel:

e Open Sitecore » Control Panel » Globalization » Add a New Language. This will start the
same dialog as described above.
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3.2 How to Remove a Language?
To remove a language from a Sitecore CMS solution:

1. Under the /sitecore/system/Languages item, select a language you want to remove.

= ¥ System
i) Aliases
® Dictionary
= Languages
Hen
™ de-DE
(1) Modules

2. Select Delete in the Home tab, just like you would do with a usual item.

3. Inthe prompt dialog, confirm that you want to delete the item and the following dialog will
appear:

Windows Internet Explorer
9, Youare about to delete the "German (Germany) [de-DE]" language.
)

This will rernove ALL the content in "German (Germarny) [de-DE]" from every item.

Are you sure you want to delete "German (Germany [de-DE]"?

ik |l Cancel ]

Click OK to proceed. The language and all content in this language will be removed.

Note
Removing a language from a Sitecore CMS solution will remove all the content in this language from
every item.

Alternatively you can remove a language via the Control Panel.

¢ Open Sitecore » Control Panel » Globalization » Delete a Language. This will start the
same dialog as described above.
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Publishing Content

This section provides instructions on various actions related to publishing.
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4.1 How to Publish an Item or a Whole Site?
To publish an item, on the Publish tab, in the Publish group, click Publish.

O Home Navigate Review Publish Versions Configure

The following dialog will appear:

Windows Internet Explorer E|

P Are you sure you want to publish "Sarmple Tem"
\f(’ in every language to every publishing target?

| (a4 |l Cancel ]

Click OK. The following dialog will appear:

Windows Internet Explorer El

! E The item is being published,

Click OK, the publishing process will run in the background and in a short period of time (the period
depends on the current publish queue and server performance, but generally the published content
appears in the target database within a few seconds).

The Publish button has a submenu which provides additional options described in the following
sections:

Publish - | L) Pre
1%  Publish site
1@ publish 1tem
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4.1.1  Publishing an Item with Advanced Options

To publish an item with advanced options, select the Publish Item sub option:

ona=
Publish - | L) Pre
Publish Site
@ Publish Ttem

The following dialog will appear:

A Sitecore -- Webpage Dialog X
Settings
Select the publishing settings. Click Publish to publish. Q
Publishing

() Smart publish - Publish Differences Between SoLrce and Target Database.:
() Republish - Publish Everything.
Publish Subitems

< Back ][ Publish > ] [ Cancel

Choose the options necessary and click Publish.

Review the summary dialog and click Finish.

4.1.2 Publishing the Whole Site

To publish the whole site, select the Publish Site sub option:

[ Pag
It =

Er

[@ | Publish site
&@ Publizh Item
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The following dialog will appear:

A Sitecore -- Webpage Dialog

Settings
Select the publishing settings. Click Publish to publish. Q

Publishing

(O Incremental Publish - Publish Only Changed Ttems.

(® Emart publish - Publish Differences Between Source and Target Database.:
O Republish - Publish Everything.

< Back ][ Publish > ] ’ Cancel

Choose the options necessary and click Publish. The following window will appear:

A Sitecore -- Webpage Dialog

Publishing
Please wait while publishing. ..

9

Publishing...
Database: Web
Language: English

Processed: 217

Note
You may close the publishing dialog before the process is completed. The publishing will continue

anyway, but you will not see the summary window.
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When the publishing process will be completed, the summary window will appear.

A Sitecore -- Webpage Dialog

The wizard has completed. Click Finish to close the
wizard.

Items processed: 540.
Click here to see additional information.

Review the window and click Finish.
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4.2 How to Hide a Version of an Item?

If an item has multiple versions, the last version by number is published unless it is hidden or has
other publishing restrictions.

To hide a version of an item:

1. Onthe Publish tab, in the Restrictions group, click the Change button:

Home Mavigate Review

@ BPagEEﬁh! &

Publish = @ Preview

2. The following window will appear:

A Sitecore -- Webpage Dialog E]

Publishing Settings
Configure how the current item is published.

Wersions |E m

Restrict the publication of one or more versions of the current item. This only affects the current language.

Version Publishable Publishable From Publishable To
L | ¥ | ] | ¥ | ]
2 |5/29/2009 v| [11:07 aM | | v | v
3. |5/28/2009 v| [11:07 AM v | v | ~|

oK ] [ Cancel

3. To hide a version of the item, clear the checkbox in the Publishable column next to the
version number.
If you want to hide the version of the item until a certain date, check the Publishable
checkbox and set the appropriate date and time in the Publishable From field.
If you want to hide the version of the item after a certain date, check the Publishable
checkbox and set the appropriate date and time in the Publishable To field.

4. Click OK.
Save the item.

The appropriate version will be put into the web database when the next publishing operation
is performed. For instance, if you have cleared the Publishable checkbox for version 3,
version 2 will be put into the web database (if it does not have restrictions in one’s turn).
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4.3 How to Unpublish an Item?
To unpublish an item and all of its versions:

1. Onthe Publish tab, in the Restrictions group, click the Change button:

2. Inthe prompt window select the Item tab:

A Sitecore -- Webpage Dialog X
Publishing Settings
Configure how the current item is published.

| versions | Ttem | Targets |

Restrict the publication of the current item. This affects every version in every language.

Publishable

Publishable From: | v| | v|

Publishable To: | ~ | | “ |

3. To unpublish the item, clear the Publishable checkbox.
If you want to unpublish the item until a certain date, check the Publishable checkbox and
set the appropriate date and time in the Publishable From field.
If you want to unpublish the item after a certain date, check the Publishable checkbox and
set the appropriate date and time in the Publishable To field.

4. Click OK.
Save the item.

6. The item will be removed from the web database when the next publishing operation is
performed.
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4.4 How to Schedule Item Publication?

Scheduling an item publication is implemented using the Sitecore Scheduled Tasks functionality and
requires some coding. The following example shows how to set up a sample scheduled task which
starts on a certain time and writes a message to file. In order to publish an item using such approach
you should write a class which implements publishing instead of the class shown in the example.

The following steps describe how to configure such a task:

1. Create your own class. This class must implement at least one public method with the
following parameters:

using System;
using Sitecore.Data.Items;
using Sitecore.Tasks;
namespace CustomScheduleTasks
{
public class Taskl
{
public void WriteToLogFile(Item[] itemArray, CommandItem
commandItem, Scheduleltem scheduledItem)
{
Sitecore.Diagnostics.Log.Info ("Test Scheduled task:
"+DateTime.Now, this);
}
}
}

2. Compile this assembly and put the resulting file, for example: CustomScheduleTasks.dll, into
the /bin folder under the Sitecore web root.

3. Inthe Content Editor navigate to the System item, locate the /System/Tasks/Commands/
folder and create a new item based on the /sitecore/templates/System/Tasks/Command
template.

= & System
) Aliases
% Dictionary
£ u Languages
() Modules
= '-LJ Proxies
+ Ca Publishing targets
= Settings
= ) Tasks

(i testCommand

# (8 Toolbox
+ T Workflows
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4. Fillin the fields of the command item:

a Content\
@ testCommand

oQuick Info
E] pata
Type [chared]:
CustomScheduleTasks. Task1l, CustomScheduleTasks

Method [zhared]:
WriteToLogFile

The Type field holds the %namespace.class%, %assembly name% value. The Method
indicates the method to call from the specified class.
Your command is now ready to use as a scheduled task.

5. Navigate to the /System/Tasks/Schedules/ folder and create the new item based on the
[sitecore/templates/System/Tasks/Schedule template.

= ) Tasks
= ) Commands
'Sﬂ testCommand
= ) Schedules
(M) _ Task Schedule

6. Fill in the fields of the schedule item:

0 Content\
@ __Task Schedule

O Quick Info

El pata
Command [shared]:
Commands/testCommand

Items [zhared]:
/sitecore/content/Home

Schedule [shared]:
20080720T235900|20090630T235900|127|00:10:00

Mow * Clear
Last run [shared]:
|5/29/2009 v| [12:46 PM v

[ Async [shared]z

Auto remove [shared]:

Command: select command created in the previous step.

Items: if you want to pass an array of items to your method you can place any XPath
expression here. Multiple items can be divided by the pipe separator. For example:
/Sitecore/content/Home/Globals/Item1|/Sitecore/content/Home/Globals/ltem?2.
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Schedule: 20080720T235900]20090630T235900|127]00:10:00.

In this example, the task will be executed from 2008.07.20 23:59:00 to 2009.06.30 23:59:00,
every day (as specified by the number 127) and every 10 minutes (as specified by 00:10:00).
In the Schedule field you can place 4 parameters divided by pipe separators:

From Date|To Date|Day of the Week|Period of time

For the day of the week DaysOfWeek enumeration is used. For example for Monday and
Friday you should write 34 (2+32)

public enum DaysOfWeek

{
None = 0,
Sunday = 1,
Monday = 2,
Tuesday = 4,
Wednesday =
Thursday =
Friday = 32
Saturday =

}

Period of time has the following format: hh:mm:ss.
Auto Remove: if this field is checked, then the schedule item will be removed (deleted) after
it is completed.

7. Setthe necessary frequency and interval parameters in the web.config:

<scheduling>

<!-- Time between checking for scheduled tasks waiting to execute -
->

<frequency>01:00:00</frequency>

<!-- Agent to process schedules embedded as items in a database -->
<agent type="Sitecore.Tasks.DatabaseAgent" method="Run"
interval="01:00:00">
<param desc="database">master</param>
<param desc="schedule
root">/sitecore/system/tasks/schedules</param>
<LogActivity>true</LogActivity>
</agent>

Note

In the environments with many instances, this task will be performed on each instance that is
connected to the database that contains the item task. This can lead to unexpected results, such as
wrong publishing or republishing of the same items if the task is designed for publishing operations.
Additional checks must be added to ensure that the task runs only on one instance.
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4.5 How to See Which Version of an Item Will be Published?

To see which version of an item will be published on a certain time you should open the Publishing
Viewer application.

On the Publish tab, in the Publish Group, select the Publish Viewer application:

The following window will appear:

A Sitecore -- Webpage Dialog X
% Publishing Viewer
When the different versions of the current item are active on the Web site.
Start date: End date:
Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat
2 3 1 3 4 5

gg;gu:ru
i
b
5

9
16

18 15 20 21 2 23 24 20 21 22
30

Today is 29 Mas 2009, Today is 29 man 2009 .

Pub.

= w
112009 12:00 AM I
£/25/2005 11:07 AM |

Use the Start Date and End Date calendar fields to select the time span you want to view.
The bars in the lower part of the window indicate whether the item or its versions can be published.
The bar coloring follows the code:

e Green: The version is active and valid for publish.

e Gray: Inactive. The version is typically superseded by a newer version.

e Blue: The period where the item is valid. It is not necessarily published.
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Chapter 5

Maintaining Search

This chapter contains notes about maintaining the search functionality in Sitecore
CMS.

5.1.1 How to rebuild the Search Index and the Link Database?

The Search Index and the Link Database can be rebuilt via the Control Panel.

Open the Control Panel (Sitecore » Control Panel):

Ed control Panel

Pick a category.
ﬁ Administration E Database

- -
A Globalization [.\ Preferences
<&

2
-~ Reports = ! Security

Select the Database section:
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El control Panel

E Database
Pick a task...

E| Rebuild the Link Database

E| Rebuild the Search Index

E| Transfer Items to Another Database

E| Clean Up Databases

E| Display Database Usage

Select the Rebuild the Link Database link to rebuild the Link Database:

A Sitecore -- Webpage Dialog @
Select Link Databases
Select the Link Databases that you want to rebuild. Clidk Rebuild to rebuild the Link 3
Databases.

Rebuild Link Databases
Ceore

master

[Cweb

[ <Back || Rebuid> | [ cancel |

Choose the databases where the Link Databases should be rebuilt and click Rebuild.
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Select the Rebuild the Search Index link to rebuild the Search Index:

A Sitecore -- Webpage Dialog

Select Search Index
Select the search index that you want to rebuild. You can rebuild more than one index at
a time. Click Rebuild to rebuild the search index.

Rebuild Search Index

[Cmaster
Quick search index

< Back ][ Rebuild = ] ’ Cancel

Choose the databases where the indexes should be rebuilt and click Rebuild.
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Administrator’s Notes

Useful tips and notes for administrators.
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6.1 Customizing Login Page

Developers may choose to customize the login page for your site. Therefore, the login page you see
may differ from the one shown in the screenshot above. Developers can choose simple changes,
such as changing the “Welcome to Sitecore” title or provide additional text by modifying the
“WelcomeTitle” and “WelcomeText” settings in the web.config.

Developers may also choose to make more significant changes to the login page by modifying the
associated .aspx, .js, .css, or image files associated with the page. The source of these related files is
under the Sitecore web root in the /sitecore/login folder.
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6.2 Changing the Default Client Language

The default client language for all users in Sitecore is English. However, it is possible to change the
default language for a certain user. To do that, follow the steps below:

Start the User Manager application: Sitecore » Security Tools » user Manager.

4% User Manager

Fully Qualified Name Full Name Email Comment Language Locked
& Anonymous default default\Anonymous
a Anonymous extranet extranet\Anonymous
A admin sitecore sitecore\Admin Administrator Sitecore Administrator

Page 10f 1 (3 items))

Select the user for whom you want to change the client language and click Edit in the Users group.

The Edit User window will appear. In this window select the Language Settings tab:

A Sitecore -- Webpage Dialog

Edit User
Edit the information about the user.

General | Member Of | Profile Language Settings l Information

Sitecore Client
Client Language: | Default

Regional ISO Code: | Default

Content
Default Content Language: | Default

In the Client Language field set the needed value.
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